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 Flooding is a major hazard in both urban and rural areas today. There 

are several factors that determine the susceptibility of an area to 

flooding, and the problem of flooding cannot be solved if the flood 

susceptible areas are unidentified. Flood susceptibility mapping is an 

important way of controlling floods because it identifies the flood prone 

regions within an area of interest. This study aims to present a method 

of determining the flood susceptible zones for a watershed area in 

Benin City using the Multi-Criteria Decision Analysis (MCDA) 

approach, particularly the Analytical Hierarchy Process (AHP) and 

Geographic Information System (GIS). Six flood conditioning factors 

were selected for the study: slope, drainage density, distance from 

rivers, flow accumulation, elevation, and curve number. These factors 

were presented as raster datasets. The factors were ranked based on 

their potential contribution to flooding and given factor weights 

according to the AHP technique. The combination of these flood 

conditioning factors with their corresponding weights in the QGIS 

software was used to produce the flood susceptibility map. From the 

flood susceptibility map, it was observed that 26.1% of the watershed 

area was characterized by very high and high susceptibility to flooding. 
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1.0. Introduction 

Flooding is one of the most serious, common, and dangerous natural disasters that many countries 

face. It is one of the natural disasters that cause damage worldwide, [1]. Flood is the second deadliest 

of all weather-related hazards and has been detrimental to many other societies in most parts of the 

world. Floods can be local, impacting a neighborhood or a community, or even as large as affecting 

regions, plains, and valleys. This extreme climatic event has the potential to cause a serious impact 

on human health, security, livelihood, and poverty. [2]. Urban regions generally have a high risk of 

flash flooding because of the presence of enormous impervious regions and sometimes inefficient 

drainage systems, [3] [4]. Increased urbanization in flood-prone regions has exacerbated challenges 

around resilience and vulnerability to recurrent flooding. 

In Nigeria, aside from droughts, floods cause almost 90 percent of the damages resulting from 

natural hazards [5]. Floods that occur in Nigeria are as a result of extensive rainfall, drainage 

blockages, and dam failures [6]. The main cause of flooding according to [7], is excessive rainfall, 

but however, there are many other causes resulting from human activities, for example: land 

degradation, deforestation of catchment areas, sprawl and increased population density along 

riverbanks, poor land use planning, zoning, and control of flood plain development; inadequate 

drainage, particularly in cities, and inadequate management of discharges from river reservoirs, [8, 

9, 10, 11], poor land use planning, zoning, and control of flood plain development; inadequate 

drainage, particularly in cities, and inadequate management of discharges from river reservoirs. 

https://www.sciencedirect.com/topics/social-sciences/flood
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Floods are also triggered by climate change, and this threatens environmental sustainability, 

economies, and ecological cycles, [23]. 

 

Identification of potential flood risk areas through mapping is crucial to reducing flood damage, and 

this risk map will guide policymakers to easily identify the vulnerable areas for flood hazards and 

suitable areas for development activities necessary to attain sustainable development, [12]. This 

approach provides valuable insights into the spatial distribution of flood risk, thereby, assisting 

policymakers and decision-makers in formulating effective flood risk reduction strategies through 

targeted flood vulnerability and risk reduction measures. [13]. 

The assessment of floods requires knowledge of flood-risk areas in order to develop prevention as 

well as mitigation measures. Flood risk maps are essential tools in the identification of flood-

vulnerable areas, [14]. The flood susceptibility map is a comprehensive resource for forecasting and 

preventing floods worldwide, particularly where floods occur on a regular basis, which is missing 

in numerous developing-country basins [15]. A flood hazard maps is an essential tool to assess the 

susceptibility of flood prone areas. [16]. Flood susceptibility and risk mapping has proven to be a 

critical tool in modern natural hazard analysis as it provides geospatial representations of hazard 

susceptibility and risk, which has become vital in land use management and planning, [17]. 

Flash floods in cities lead to high levels of water in the streets and roads, causing many problems 

such as bridge collapse, building damage, and traffic problems. It is impossible to avoid the risks of 

floods or prevent their occurrence, however, it is plausible to work on reducing their effects and the 

losses that they may cause. Flash flood mapping to identify sites in high risk flood zones is one of 

the powerful tools for this purpose, [18]. 

It has been reported that identification of flood-susceptible areas and taking necessary structural and 

non-structural measures in the identified areas can effectively reduce property damage, fatalities, 

and economic losses. Therefore, mapping flood-prone areas is considered the most important step 

in flood management and mitigation. The objective of flood hazard mapping is to classify a region 

into different zones according to their susceptibility to floods, [19]. 

Numerous techniques have been proposed for multi-criteria decision making, and the Analytic 

Hierarchy Process (AHP), developed by [20], is going to be adopted for this study.  

Flooding is a recurrent and severe natural hazard in Benin City, exacerbated by climate change, and 

poses significant threats to human lives and livelihoods by affecting its inhabitants and disrupting 

socio-economic activities as have been the case during previous flooding events in this area. In this 

study, a GIS-based approach was utilized to delineate flood-prone zones within the watershed area 

using Digital Elevation Models (DEMs). DEM-derived features, including slope, drainage density, 

distance from rivers, flow accumulation, and elevation, were developed using QGIS. While previous 

research works on flood susceptibility mapping in Benin City have not taken into account the curve 

number of the catchment, this research considers curve number of the catchment as one of the flood 

causative factors, as the catchment hydrological soil group and land use are also important factors 

affecting flooding. The AHP was used in the study to assign ranks to the classes of each causative 

flood factor. The result of the study provides a simplified method of mapping and assessing flood 

susceptible areas, which can be used as a reference for flood mitigation, prevention, and reduction 

of natural disasters within the study area. 
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2.0.Materials and Method 

2.1. Study Area 

The study area, which is represented by a watershed, is located in Oluku, Benin City, Edo State, 

Nigeria, and covers specific places such as Oluku Market, Terminal Resort and Park, Sacred Heart 

Nursery and Primary School, Iguosa Housing Estate, Oluku Bypass, and others. The watershed 

(catchment) area covers an area of 28.82 km2 as shown in Figure 3.1. The coordinates of the study 

area are enclosed in the bounding box: 5.5667oE, 5.6339oE, 6.5000oN, 6.4167oN. The study area 

lies within the Ikpoba river basin, and all the rainfall in the study area flows and ultimately 

discharges into Ikpoba River in Benin City. The calculated area of the watershed was found to be 

28.82 km2. Annual precipitation in Benin City is around 190 mm and there are 274.89 rainy days 

(75.31% of the year).  

 
Figure 1. Study Area for Flood Susceptibility Mapping 

 

2.2.Flood Conditioning Factors and Methods of Processing 

Flood susceptibility mapping requires various input data that was collected from different sources 

and processed in QGIS. The original data, which were used to process flood conditioning factors, 

and their sources are reported in Table 1. 
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Table 1. Data sources used for the processing of flood conditioning factors 

Data Format Source Resolution(m) 

Digital elevation model 
(DEM) 

Raster file United States Geological Survey 
(USGS) 

30 

Land use/ land cover  Raster file Environmental Systems 
Research Institute (ESRI) 

307 

Global hydrologic soil 
groups 

Raster file NASA EARTH DATA 230 

 

Due to their relevance to flooding [21], six flood conditioning factors were selected for the spatial 

modeling. They are: slope (˚), river network density (km/km2), distance from rivers (m), flow 

accumulation (pixels), elevation (m), and curve number. All of the flood conditioning factors were 

processed in the GIS software and are summarized below. 

 

2.2.1. Map of elevation 

Elevation usually affects flooding in an inverse way, i.e., flooding increases with lower elevation, 

meaning that lower elevations are more susceptible to flooding. The map of elevation was simply 

obtained from the Digital Elevation Model (DEM). 

 

2.2.2. Map of slope 

Another significant physical factor in flooding is slope. Areas with a steep slope tend to have more 

runoff and less infiltration into the ground. This increased overland flow can cause flooding. The 

slope degree map was generated from the DEM in QGIS by going to Raster > Analysis > Slope. 

 

2.2.3. Map of flow accumulation 

The accumulated flow is based on the number of cells flowing into each cell in the output raster. 

The current processing cell is not considered in this accumulation. Output cells with higher flow 

accumulation are areas of concentrated flow. In this sense, an increase in flow accumulation should 

reflect an increase in flood susceptibility. Convert the DEM to PCRaster format and calculate the 

flow direction map; the flow accumulation was derived from the flow direction raster.  

 

2.2.4. Map of distance from rivers 

Distance from rivers is another important conditioning factor since rivers and their adjacent lands 

are the main pathways for flooding. In order to generate the distance from rivers/distance from 

streams map, the streams were first delineated in the DEM. This map in ArcGIS was generated by 

going to Geoprocessing ArcToolbox > Spatial Analyst Tools > Distance > Euclidean Distance Tool. 

 

2.2.5. Map of river network density 

As for the river network density, a higher density generally means increased surface runoff and thus 

an increased probability of flooding, while a lower density means reduced surface runoff and hence 

a lower probability of flooding. The surface area of the catchment was calculated in the open field 

calculator of the attribute table by going to geometry > $area, and the total length of the stream 

network was also calculated by going to Vector > Geoprocessing Tools > Dissolve. This river 

network density map was generated from the “LineDensity” tool in the QGIS processing toolbox 

with the dissolved file as the input layer 
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2.2.6.Map of curve numbers 

Curve numbers are a measure of the rainfall-runoff coefficient of the area, and the ease of runoff of 

the soil is also a factor that determines flooding. High curve number values indicate low 

permeability and, therefore, a high likelihood of flooding. Hydrologic soil groups and land use/ land 

cover data represented the inputs for the calculation of curve numbers. The curve numbers were 

calculated using the GDAL raster calculator in QGIS by querying each cell of the input raster and 

assigning a curve number value based on the published curve number tables by the Natural 

Resources Conservation Service (NRCS). 

 

2.3. Classification of Flood Conditioning Factors 

In order for the conditioning factors to be comparable, they were reclassified into five susceptibility 

classes (5—very high, 4—high, 3—moderate, 2—low, and 1—very low) based on their potential 

contributions to flooding and other criteria mentioned earlier. This classification is shown in Table 

2. 

 

Table 2. Classes of conditioning factors estimated ratings, and relative importance. 

Factor Class Rating Relative importance 

 
 
Slope (˚) 

0.0-2.5 5  
 
6 

2.5-5.0 4 

5.0-15.0 3 

15.0-30.0 2 

>30 1 

 
 
River network density (km/km2) 

0-0.00152 1  
 
5 

0.00152-0.00216 2 

0.00216-0.00271 3 

0.00271-0.00328 4 

0.00328-0.00521 5 

 
 
Distance from rivers (m) 

0-30 5  
 
4 

30-90 4 

90-200 3 

200-500 2 

500-1070 1 

 
 
Flow accumulation(pixels) 

0-70 1  
 
3 

70-150 2 

150-900 3 

900-6000 4 

6000-30600 5 

 
 
Elevation (m a.s.l.) 

<70 5  
 
2 

70-90 4 

90-125 3 

125-150 2 

150-183 1 

 
 

71-78 1  
 78-81 2 



                                G. U. Okafor, &O. Oriakhi / NIPES - Journal of Science and Technology Research 

6(3) 2024 pp. 229 -242 

234 

 

Curve number 81-83 3 1 

83-86 4 

>86 6 
 

The classes for the flood conditioning factors were adjusted according to the natural break (Jenks) 

grading method. 

 

2.4.Multi-Criteria Decision Analysis: Analytical Hierarchy Process (AHP) 

The parameter weights were calculated through the AHP technique. The pairwise comparison 

process is the main part of the AHP technique, which determines each parameter weight. The values 

and criteria of the parameters are given to indicate their relative importance between two 

parameters. The relative importance of the selected conditioning factors was assigned based on 

empirical knowledge of hydrology as some of the flood conditioning factors will have a greater 

influence on flooding than others, and also similar approach have been used in recent studies like 

[21]. It ranges from 6 (highest importance) to 1 (lowest importance). In order to estimate the weights 

for each criterion (flood conditioning factor), the technique of pairwise comparisons known as the 

AHP was used. The relative weights were derived by taking the principal eigenvector of a square 

reciprocal 6 × 6 matrix of pairwise comparison between the criteria. The pairwise comparison 

matrix is shown in Table 3. 

 

Table 3. Pairwise comparison matrix 

Factors Slope River 
network 
density 

Distance 
from rivers 

Flow 
accumulation 

Elevation Curve 
numbers 

Slope 1 2 3 4 5 6 

River network 
density 

0.5 1 2 3 4 5 

Distance from 
rivers 

0.33 0.5 1 2 3 4 

Flow 
accumulation 

0.25 0.33 0.5 1 2 3 

Elevation 0.2 0.25 0.33 0.5 1 2 

Curve numbers 0.167 0.2 0.25 0.33 0.5 1 
 

The normalized factor weights and final weights (Wi) were calculated by the approximation method 

and are shown in Table 4. 

 

Table 4. The normalized factor weights and final weights (Wi) 

Factors Slope River 
network 
density 

Distance 
from rivers 

Flow 
accumulati
on 

Elevation Curve 
numbers 

Weight 
(Wi) 

Slope 0.408 0.467 0.423 0.369 0.323 0.286 0.379 

River network 
density 

0.204 0.233 0.282 0.277 0.258 0.238 0.249 
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Distance from 
rivers 

0.136 0.117 0.141 0.185 0.194 0.191 0.161 

Flow 
accumulation 

0.102 0.078 0.071 0.092 0.129 0.143 0.102 

Elevation 0.082 0.058 0.047 0.046 0.065 0.095 0.065 

Curve 
numbers 

0.068 0.051 0.035 0.031 0.032 0.048 0.044 

 

After completing the AHP, the consistency ratio (CR) was calculated in order to examine the 

consistency of the developed ratings. The formula for calculating the consistency ratio is shown in 

equation 1: 

       CR=
𝐶𝐼

𝑅𝐼
 …………………………………...………………(1) 

 

Where RI is the random index, which depends on the number of conditioning factors used, and CI 

is the consistency index, which is given by equation 2: 

 

                  CI=
𝜆𝑚𝑎𝑥 −𝑛

𝑛−1
………………………………….……………(2) 

 

Where n is the number of conditioning factors and 𝜆𝑚𝑎𝑥 is the average value of the consistency 

vector. According to Saaty (1980), the average value of the consistency vector should be less than 

0.1 for the AHP to be consistent. 

In this case, our value of 𝜆𝑚𝑎𝑥 was calculated to be 6.122, and therefore, CI was calculated using 

equation 2. 

CI = 
𝜆𝑚𝑎𝑥 −𝑛

𝑛−1
 = 

6.122 −6

6−1
 = 0.0244 

From equation (1),  

CR =
𝐶𝐼

𝑅𝐼
 

Table 5 shows the RI values. 

 

Table 5. Various numbers of factors and their corresponding Random Index RI 

n 1 2 3 4 5 6 7 8 9 10 

RI 0 0 0.58 0.9 1.12 1.24 1.32 1.41 1.45 1.51 
(Saaty, 1980). 

 

The value of the random index (RI) for six factors is 1.24. Then, CR was calculated using equation 

1 as 

CR = 
0.0244

1.24
 = 0.01968 

This value of CR is less than 0.1, so this confirms the consistency of the ratings used. 

 

2.5.Generation of the Flood Susceptibility Map 

After each flood conditioning factor had been generated into separate raster files and successfully 

classified into 5 classes, the weights of each factor as obtained earlier were multiplied by the 

corresponding flood conditioning factor map in the raster calculator in the QGIS software to get the 

final flood susceptibility map. The raster calculator expression is shown below: 

SlopeRaster * 0.379 + StreamdensityRaster * 0.249 + DistancefromriversRaster * 0.161 + 

FlowaccumulationRaster * 0.102 + ElevationRaster * 0.065 + CurvenumberRaster * 0.044. 
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After the flood susceptibility map had been created, the natural breaks (Jenks) grading method was 

used to classify the final flood susceptibility map into 5 different classes, which were: very high, 

high, moderate, low and very low susceptibility to flooding.  

 

3.0.Results and Discussion 

3.1.Slope 

This represents the rate of change in elevation. For this work, this is the factor that is taken to have 

the most contribution to flooding. For our catchment area, the slope ranges from 0° to 33.69°. Zero 

degrees is the portion with the lowest slope and hence most likely to be flooded, and 33.69 degrees 

is the portion with the highest slope and hence less likely to be flooded. The processed map of the 

slope of our catchment area is shown in Figure 2. 

 

   
Figure 2. Slope of catchment               Figure 3. River network density of catchment 

 

3.2. River Network Density 

River network density is taken to have the second highest contribution to flooding. The drainage 

density of our catchment area ranged from 0 km/km2 to 0.00521 km/km2. Where 0 km/km2 

represents the region with the lowest river network density, hence giving the least contribution to 

flooding, and 0.00521 km/km2 represents the region with the highest river network density, hence 

giving the most contribution to flooding. This is shown in Figure 3. 

 

3.3.Distance from Rivers 

This is the factor that is considered to have the third highest contribution to flooding. This is the 

distance in meters from each cell in the raster data to the nearest stream network. From Figure 4, 0 

m indicates the portion of our catchment that is exactly at streams, while the farthest distance, which 

is 1060 m, indicates the portion that is relatively far from the streams. 
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Figure 4. Distance from rivers of catchment    Figure 5. Flow accumulation of catchment 

 

3.4. Flow Accumulation 

The result of flow accumulation is a raster of accumulated flow to each cell, as determined by 

accumulating the weight of all cells that flow into each downslope cell. Output cells with a high 

flow accumulation are areas of concentrated flow and can be used to identify stream channels. Flow 

accumulation is usually measured in pixels; the higher the pixel value, the higher the flow 

accumulation at that point. From the flow accumulation of our catchment area, a 1 pixel value 

represents the region with the least flow accumulation, while a 30499 pixel value represents the 

region with the highest flow accumulation. This is shown in Figure 5. 

 

3.5.Elevation 

This is the DEM of our catchment area. It is measured in meters above mean sea level (m a.m.s.l.). 

This distance ranges from 52 m to 183 m above mean sea level. The region with the lowest elevation 

is more susceptible to flooding, while the region with the highest elevation is less susceptible to 

flooding. This is shown in Figure 6. 
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Figure 6. Elevation of catchment        Figure 7. Curve Number of catchment 

 

3.6.Curve number 

Curve number (CN) is a hydrological parameter used to describe the stormwater runoff potential for 

our catchment area. A high curve cumber (such as 98 for impervious pavement) indicates low 

infiltration and high runoff, while a low curve number (such as 30 for certain wooded areas) 

indicates high infiltration and low runoff. The curve number for our catchment area ranges from 71 

to 87, as shown in Figure 7. 

 

3.7.  Analysis of the Flood Susceptibility Map 

With regard to the AHP method, this natural breaks (Jenks) grading method is considered to be the 

most appropriate for classifying the flood susceptibility zones [21]. The reclassified flood 

susceptibility map is shown in Figure 8. 
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Figure 8. Flood Susceptibility Map 

 

The areas occupied by each of these five flood susceptibility zones were then calculated, and the 

data is presented in Table 6. 

 

Table 6. Area coverage of flood susceptibility classes. 

Flood Susceptibility Area(km2) Area (%) 

Very low 5.594 22.4 

Low 6.028 24.1 

Moderate 6.834 27.4 

High 4.497 18 

Very High 2.034 8.1 
 

As for the share of flood susceptibility classes (area percentage), the lowest share was recorded in 

the very high (8.1%) class, and the high flood susceptibility class covers an area of 18%, while the 

low susceptibility class recorded the share of 24.1% and the very low susceptibility class recorded 

the share of 22.4%. The highest share (27.4%) occurred in the moderate flood susceptibility class. 
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3.8. Discussion 

Although the AHP method was successfully applied for the flood susceptibility mapping in our 

study, as confirmed by its good accuracy, there could be remarks, sources of uncertainty, and 

possible limitations that need to be addressed for the study. 

The first possible issue is a number of flood conditioning factors and also the question of what order 

the flood conditioning factors should be selected for the AHP analysis in order to best characterize 

the physical characteristics that determine the susceptibility of the study area to flooding, as it is an 

adjustment by the experts. There are various numbers of parameters used in different studies of 

flood susceptibility determination using AHP, but in this study, six conditioning factors have been 

selected, as in similar studies like [22, 23]. Some studies have used as low as four flood conditioning 

factors, such as, [24, 25]. Others have used seven, for example [26], while some have also used as 

many as ten, [27, 28] and twelve [29] flood conditioning factors. This goes to show that no exact 

agreement exists on which factors should be applied for flood susceptibility analysis. However, it 

is generally recommended to use not less than six factors in order not to produce unrepresentative 

weights dominated by a single weight, which may increase the possibility of over-rating some of 

the flood contributing factors, [28].  

 Furthermore, some flood conditioning factors recur in multiple studies and thus can be 

considered as basic factors, indicating their important relevance for flood susceptibility mapping. 

These basic factors are represented by slope, elevation, land use/land cover, and distance from 

rivers/river network density. In this study, the flood-causative parameters can be grouped into 

categories as follows: (1) hydrography factors: river network density, distance from rivers; (2) 

hydrological factors: flow accumulation; (3) morphometric factors: elevation, slope; and (4) 

permeability factors: curve numbers. In this research, six flood conditioning factors were selected 

that involved only the physical characteristics of the catchment area. In this respect, the exclusion 

of causal rainfall factors from the set of flood conditioning factors might also be considered one of 

the possible limitations. However, rainfall is a factor that has been excluded in the study since it is 

considered a dynamic parameter that can change rapidly over time. As mentioned before, the 

purpose of this study was to show the physical properties (static parameters), which are not 

changeable or likely to change through time, that influence flood susceptibility. This approach was 

also presented in other studies, such as [24, 18, 25, 30, 21]. 

Another important issue in determining the flood susceptibility zones using the MCDA is the 

process of assigning relative importance to the selected conditioning factors. For this study, slope 

has been assigned the highest relative importance, indicating that slope is considered the most 

important conditioning factor for finding areas susceptible to flooding. The relative significance of 

the rest of the conditioning factors used in this study decreases as follows: river network density, 

distance from rivers, flow accumulation, elevation, and curve number. A similar approach to 

prioritizing the flood conditioning factors was also used and verified in other studies, such as [31]. 

 

4.0.  Conclusion 

The study aimed to determine the flood susceptibility zones for the study area using the Analytical 

Hierarchy Process (AHP) technique and GIS. The watershed area, which represented our area of 

interest, was successfully delineated with QGIS, and six flood conditioning factors were chosen in 

order to capture the complexity of the physical characteristics of the study area. In order not to 

underestimate or overestimate some category of factors, the following factors were selected: two 

hydrography factors—river network density and distance from rivers; one hydrological factor—

flow accumulation; two morphometric factors—elevation and slope; and one permeability factor—

curve number.  
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The flood conditioning factors were ranked, and the AHP technique was used to calculate the factor 

weights. The relative importance of the selected conditioning factors prioritized the slope as the 

most important factor for finding areas susceptible to flooding, followed by river network density, 

distance from rivers, flow accumulation, elevation, and curve number. The aggregation method was 

used to combine the reclassified factors and produce the resulting flood susceptibility map, which 

contains five classes: very low, low, moderate, high, and very high susceptibility. Finally, the 

presented approach for flood susceptibility analysis can provide a suitable alternative for the review 

of preliminary flood risk assessment and the identification of potential significant flood risk zones. 
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